Appendix A- Code Sheet

APPENDIX A

Prompt/Question Field Variable Type | Font Pattern, Table, or
Name for Option Selection
Prompt
Parent School Asthma Pre- PreSurvey Label/Title 14, Bold
Intervention Survey
Please answer all the questions | Instruction | Label/Title 12
below, whether or not your
child has asthma.
School Number SchoolNum | Text Code Table link to
PSNumber:
A to 123
B to 234
C to 345
D to 456
Student ID Number StudentID | Text Required
Zip Code Zip Text
Child's Last Name ChildTast Text
Child's First Name ChildFirst Text
Male/Female Gender Text Legal value:
Male
Female
Child's Date of Birth DOB Date Required
MM/DD/YYYY
Age Age Number Read Only
HH
Your Last Name Yourlast Text
Your First Name YourFirst Text
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Your relationship to Child Relation Text
Home Phone Number Phone PhoneNumber HHH-HHH-HHHH
PS School Number PSNumber | Text Read Only
Code Table link to
SchoolNum
Grade Grade Number it
Today's Date TDate Date MM/DD/YYYY
Has a health professional ever | Condition Label/Title
told you that your child has any
of the following conditions?
Asthma Asthma Checkbox
Reactive Airway Disease RAD Checkbox
Asthmatic Bronchitis or Bronchitis Checkbox
Wheezy Bronchitis
Wheezing Wheezing Checkbox
Has a health professional Medication | Yes/No
prescribed any medication to
your child?
How many times did your Emergency | Number Hit
child have an emergency visit
for breathing problems?
How many times did your Overnight | Number Hit
child have to stay overnight in
the hospital for breathing
problems?
Does your child take medicine | DailyMed Yes/No
every day for breathing
difficulties?
Select the month when your WMonth Text Comment Legal
child's breathing was the worst.
1- January
2- February
3- March
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4- April

5- May

6- June

7- July

8- August

9- September
10- October
11- November
12- December

During their worst breathing | Symptoms | Label/Title
month, select how often the
following symptoms occurred.

Wheeze or whistling in the Whistle Text

chest? Legal Values are:

Never

2 times each week
or less

3 to 6 times each
week

Every day but not
all day

Every day and all
day

Have a cough? Cough Text Legal Values are:

Never

2 times each week
or less

3 to 6 times each
week

Every day but not
all day

Every day and all
day

Have a tight chest or shortness | ShortB Text
of breath?

Legal values are:

Never

2 times each week
or less

3 to 6 times each
week

Every day but not
all day

Every day and all
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day

Wake up at night~ from WakeUp Text egal Values are:

wheezing, coughing, or trouble

breathing? Never
2 times each week
ot less
3 to 6 times each
week
Every day but not
all day
Every day and all
day

How many days of school has | MissDays Number ERERSS

your child missed due to

asthma?

Have breathing problems MissSport Yes/No

stopped your child from

participating in sports?

If Yes, how many times in the | SpTimes Text Legal Value

past month?
2 times a month or
fewer
3 to 4 times a
month
1 to 3 times each
week
4 times each week
or more

How many people living in IIHome Number HH

your home, including this
child, have asthma?




Appendix B- Parent School Asthma Pre-

Intervention Survey

APPENDIX B

Please answer all the questions below, whether or not your child has asthma. If you receive more than one questionnaire, please
complete a separate questionnaire for each of your children who attend this school. Your answers will help the school nurse
provide information and medical assistance to children and their families who have asthma.

School Number Student ID Number Zip Code
Child's Name (Last, First) Male/Female Child's Date of Birth | Age
(Citcle One)
Your Name (Last, First) Your Relationship  to | Home Phone Number
Child
PS School Number Grade Today's Date
School Number Student ID Number
1. Has a doctor, nurse or other health professional ever told you that your child has any of the following conditions?
(Please check “Yes” ot “No”.)
a. Asthma O Yes O No
b. Reactive Airway Disease O Yes O No
c. Asthmatic Bronchitis or Wheezy Bronchitis O Yes O No
d. Wheezing O Yes O No
2. During the past school year (September 1, 2002 — June 30, 2003), has a doctor, nurse or other health
professional prescribed any medicine for asthma, wheezing, cough, bronchitis, or other breathing problems?
(This conld include pills, syrups, inhalers or breathing machines.) O Yes O No

3. During the past school year (September 1, 2002 — June 30, 2003), how many times did your child have
an emergency visit to a doctor, clinic or an emergency room for asthma, wheezing, cough, bronchitis,

or other breathing problems? (Ewnter the number. 1f none,

enter “0” or “None”.

4. During the past school year (September 1, 2002 — June 30, 2003), how many times did your child have
to stay overnight in the hospital (not the emergency room) for asthma, wheezing, cough, bronchitis, or
other breathing problems? (Enter the number. 1f none, enter “0” or “None”.

5. Does your child take any medication every day for asthma or other breathing

difficulties, even when he or she is feeling well?

O Yes

(Number of times)

(Number of times)

O No

6. Think about your child’s breathing difficulties over the past school year (September 1, 2002 — June 30, 2003). Please check the
month that you feel your child’s breathing was the WORST.

O Sept. O Oct. O Nov. ODec. OJan. O Feb. O Mar. O April O May [ June

O Not applicable, my child did not have breathing difficulties in the past

school year (September 1, 2002 — June 30, 2003).
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When thinking about your child’s breathing difficulties during the month you checked above,
Mark an “X” in the box that best describes how often each of the following symptoms happened:

wheeze or whistling O | Never | O 2 times each week O | 3to 6 times O | Every day but O| Every day
in the chest? or less each week not all day and all day
have a cough? O | Never | O 2 times each week O | 3to 6 times O | Every day but O| Every day
or less cach week not all day and all day

have a tight chestor | O | Never | O 2 times each week O | 3to 6 times O | Every day but O| Every day
shortness of breath? or less cach week not all day and all day
wake up at night O | Never | O 2 times each week O | 3to 6 times O | Every day but O Every day
from wheezing, or less each week not all day and all day
coughing or trouble
breathing?
8. During the past school year (September 1, 2002 — June 30, 2003), how many days of school has your

child missed due to asthma or other breathing difficulties?

(Enter the number. 1f none, enter “0” or “None”.

(Number of days)

9.  During the past month, has asthma or other breathing problems ever stopped your child O Yes O No

from participating in sports or other physical activities?

If “YES”, how many times in the past month? (Please check only one box.)
O | 2 times a month or fewer | O | 3to04timesamonth | O 1to3times each week | O | 4 times each week or more
10. How many people living in your home, including this child, have asthma?

(Enter the number. If none, enter “0” or “None”.)

(Number of people)

Reprinted with the permission of the New York City Department of Health and Mental Hygiene
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Appendix C- Data Entry Surveys

Please answer all the questions below, whether or not your child has asthma. If you receive more than one questionnaire, please
complete a separate questionnaire for each of your children who attend this school. Your answers will help the school nurse
provide information and medical assistance to children and their families who have asthma.

School Number A Student ID Number 11 Zip Code 1 2208

Child's Name (Last, First) Gender Child's Date of Birth | Age

Evans, Katie Female 11/30/1994 | 10

Your Name (Last, First) Relationship to Child Home Phone Number

Evans, Rebecca Mother 555-555-5555

PS School Number Grade Today's Date
th /25/
1273 5 10/25/2005
| School Number | Student ID Number
1. Has a doctor, nurse or other health professional ever told you that your child has any of the following conditions?
(Please check “Yes” or “No”.)

a. Asthma Yes O No
b. Reactive Airway Disease B Yes ONo
c. Asthmatic Bronchitis or Wheezy Bronchitis B Yes ONo
d. Wheezing Yes O No

2. During the past school year (September 1, 2002 — June 30, 2003), has a doctor, nurse or other health
professional prescribed any medicine for asthma, wheezing, cough, bronchitis, or other breathing problems?
(This conld include pills, syrups, inhalers or breathing machines.) EYes O No

3. During the past school year (September 1, 2002 — June 30, 2003), how many times did your child have
an emergency visit to a doctor, clinic or an emergency room for asthma, wheezing, cough, bronchitis,
or other breathing problems? (Enter the number. If none, enter “0” or “None”.) 2
(Number of times)
4. During the past school year (September 1, 2002 — June 30, 2003), how many times did your child have
to stay overnight in the hospital (not the emergency room) for asthma, wheezing, cough, bronchitis, or
other breathing problems? (Eunter the number. 1f none, enter “0” or “None”.) 1
(Number of times)

5. Does your child take any medication every day for asthma or other breathing Yes ONo
difficulties, even when he or she is feeling well?

6.  Think about your child’s breathing difficulties over the past school year (September 1, 2002 — June 30, 2003). Please check the
month that you feel your child’s breathing was the WORST.

BbSept. O Oct. ONov. ODec. OJan. O Feb. O Mar. O April OMay O June

O Not applicable, my child did not have breathing difficulties in the past
school year (September 1, 2002 — June 30, 2003).

7. When thinking about your child’s breathing difficulties during the month you checked above,
Mark an “X” in the box that best describes how often each of the following symptoms happened:
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wheeze or whistling O | Never | Bd 2 times each week O | 3to 6 times O | Every day but O Every day
in the chest? or less each week not all day and all day
Have a cough? O | Never | K 2 times each week O | 3to 6 times O | Every day but O Every day
or less each week not all day and all day

have a tight chestor | O | Never | B 2 times each week O | 3to 6 times O | Every day but O Every day
shortness of breath? or less each week not all day and all day
wake up at night O | Never | B 2 times each week O | 3to 6 times O | Every day but O| Every day
from wheezing, or less each week not all day and all day
coughing or trouble
breathing?
8. During the past school year (September 1, 2002 — June 30, 2003), how many days of school has your

child missed due to asthma or other breathing difficulties?

(Enter the number. If none, enter “0” or “None”, 12

(Number of days)

9. During the past month, has asthma or other breathing problems ever stopped your child B Yes O No

from participating in sports or other physical activities?

If “YES”, how many times in the past month? (Please check only one box:)
O | 2 times a month or fewer | [ | 3 to 4 times a month | Dl 1 to 3 times each week I O I 4 times each week or more
10. How many people living in your home, including this child, have asthma?

(Enter the number. If none, enter “0” or “None”. 0,

(Number of people)

Reprinted with the permission of the New York City Department of Health and Mental Hygiene
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Please answer all the questions below, whether or not your child has asthma. If you receive more than one questionnaire, please
complete a separate questionnaire for each of your children who attend this school. Your answers will help the school nurse

provide information and medical assistance to children and their families who have asthma.

School Number A

Student ID Number 12

Zip Code

12203

Child's Name (Last, First)

Williams, Beth

Gender

Female

Child's Date of Birth

11/08/1995

Age

Your Name (Last, First) Relationship to Child Home Phone Number
Williams, Susan Mother 333-333-3333
PS School Number Grade Today's Date

th

1273

5

10/25/2005

School Number

| Student ID Number

1. Has a doctor, nurse or other health professional ever told you that your child has any of the following conditions?

(Please check “Yes” or “No”.)
a. Asthma
b. Reactive Airway Disease

c. Asthmatic Bronchitis or Wheezy Bronchitis

d. Wheezing

2. During the past school year (September 1, 2002 — June 30, 2003), has a doctor, nurse or other health
professional prescribed any medicine for asthma, wheezing, cough, bronchitis, or other breathing problems?
(This conld include pills, syrups, inhalers or breathing machines.)

EYes ONo
EYes ONo
O Yes [ONo
X Yes ONo
B Yes [ONo

3. During the past school year (September 1, 2002 — June 30, 2003), how many times did your child have
an emergency visit to a doctor, clinic or an emergency room for asthma, wheezing, cough, bronchitis,
or other breathing problems? (Ewnter the number. If none, enter “0” or “None”,

5. Does your child take any medication every day for asthma or other breathing
difficulties, even when he or she is feeling well?

0

(Number of times)
4. During the past school year (September 1, 2002 — June 30, 2003), how many times did your child have
to stay overnight in the hospital (not the emergency room) for asthma, wheezing, cough, bronchitis, or
other breathing problems? (Enter the number. 1f none, enter “0” or “None”.)

0

(Number of times)

O Yes

XINo

6. Think about your child’s breathing difficulties over the past school year (September 1, 2002 — June 30, 2003). Please check the
month that you feel your child’s breathing was the WORST.

O Sept. O Oct. O Nov. ODec. OJan. OFeb. O Mar. O April 0O May B June

O Not applicable, my child did not have breathing difficulties in the past
school year (September 1, 2002 — June 30, 2003).

7. When thinking about your child’s breathing difficulties during the month you checked above,
Mark an “X” in the box that best describes how often each of the following symptoms happened:

wheeze or whistling O | Never 2 times each week 3 to 6 times Every day but Every day
in the chest? or less each week not all day and all day
have a cough? O | Never 2 times each week O | 3to 6 times O | Every day but O| Every day

or less each week not all day and all day
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have a tight chest or Bd | Never | O 2 times each week O | 3to 6 times O | Every day but O| Every day
shortness of breath? or less each week not all day and all day
wake up at night O | Never | ® 2 times each week O | 3to 6 times O | Every day but O| Every day
from wheezing, or less each week not all day and all day
coughing or trouble

breathing?

8. During the past school year (September 1, 2002 — June 30, 2003), how many days of school has your
child missed due to asthma or other breathing difficulties?

(Enter the number. If none, enter “0” or “None”, 14
(Number of days)
9.  During the past month, has asthma or other breathing problems ever stopped your child O Yes BINo

from participating in sports or other physical activities?
If “YES”, how many times in the past month? (Please check only one box.)

O | 2 times a month or fewer | O | 3 to 4 times a2 month | |:|| 1 to 3 times each week I O I 4 times each week or more

10. How many people living in your home, including this child, have asthma?
(Enter the number. If none, enter “0” or “None”. 0
(Number of people)

Reprinted with the permission of the New York City Department of Health and Mental Hygiene
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Appendix D Skills Reviews Answer Key

Lesson 2 Check Code

Check Code can run Before or After values
are entered in a variable.

True

From the Program Editor, you assign when
Check Code will run by using the Before or
After radio buttons in the Check Commands
window.

Using the Program Editor, you can create
Check Code that will run across pages or
records.

True

From the Program Editor, Check Code can
be added to pages and records using the

Choose Field Where Action Will Occur
drop-down menu.

In the Check Command window, variables
tagged with an X have Check Code
associated with them.

False

Variables with Check Code are tagged with
an *asterisk.

Which Function is used to create an age
variable.

YEARS

The YEARS function returns the number of
years from variable 1 to variable 2 in a
numetic format.

For example, Age=YEARS(DOB, Today's
Date)

How does the answer Yes appear in the
Program Editor?

)

The symbol (+) is equal to Yes or True
values. The symbol (-) is equal to No or False
values.

Lesson 3 Enter Data

Once you create a you cannot
change field names or types in your view.

Data Table

Once you begin entering records into the
data table, you cannot change field names or
types without deleting data that has been

11
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entered.

What are the two ways you can enter a new
record?

Clicking New or tabbing through to the last
record will allow you to begin a new record.

If you are entering data and have a required
field, you must enter information into that
field before proceeding to the next page.

True

Enter will not allow you to leave a page until
all Required fields are completed.

What expression could you enter in the Find | Age>6
feature to locate children who are greater

than 6 in age?

From the Find feature, what button do you | Reset

click to clear the page and begin a new
search?

The Reset button will clear all search options
without leaving the Find feature window.

Lesson 4 Analysis Basics

After you run a command, the code appears
in which window?

Program Editor

Codes appear in the Program Editor and can
be saved as programs.

What command allows you to open a project
for analysis?

READ

You must READ a project into Analysis
before creating any statistics or data
management.

What command would you use to see
variables and records in the current data
table?

LIST

The LIST command creates a listing of the
current data table and records.

What command would you use to specify a
sequence for records to appear?

SORT

The SORT command organizes listed data in
and ascending or descending order based on
selected variables.

What are the two Display Modes you can use
with the LIST command?

Web (HTML) and Grid

The LIST command allows you to view
information embedded in the Output
window as HTML or in a grid table format.
There is a third Display Mode called List

12
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Allow Updates, which allows you to edit
records. This is covered in the Intermediate
Analysis lesson.

Lesson 6 Epi Graph

You can use a Line Graph to determine
trends and cyclic variation.

True

Line Graphs can display data that varies
along an accepted sequence such as time,
temperature, etc.

Which type of graph presents a circular
proportional assessment by comparing data
elements such as percentages or counts
against the sum of the data elements?

Pie Graph

Pie Graphs are used for proportional
assessment by comparing data elements such
as percentage or count against the sum of
data elements.

From Epi Graph, select the 2 ways you can
open the Customization dialog box.

Right click and select Customization or select
View>Customization

Graphs can be exported for use in other
programs such as MS Word, PowerPoint, or
Epi Report.

True

Select File>Export from Epi Graph and
choose your export options.

You can plot a new graph type from an
existing graph using the Customization dialog
box.

True

Open the Customization dialog box and
select the Plot tab. Select a new Plot Style and
click Apply.

Lesson 7 Analysis: Exporting Files

Which command allows you to designate a
new Output file?

ROUTEOUT

The ROUTEOUT command directs output
to a named file until the process is terminated
by the CLOSEOUT command or by exiting
Analysis.

Which command allows you to create a new
variable?

DEFINE

The DEFINE command allows you to create

new vatiables. The most common type being
Standard.

13
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Which command allows you to store the
value of a variable or assigns the result of a
mathematical expression.

ASSIGN

This command assigns the value of an
expression to a vatiable. It is commonly used
after a new variable is created with the
DEFINE command.

When changing, assigning, or selecting text
fields, the value must be enclosed in what?

"Quotes"

Quotes are used to enclose text strings.

In the Program Editor, the value of Missing
appears how?

()

This symbol denotes a missing value in your
data table.

To change a number variable to a date, which
function would you use?

NUMTODATE

'This function transforms three numbers into
a date format.

Which command allows you to create a new
data table?

WRITE

WRITE will send records to an output table
or file in the format that you specify. You
can specify what variables will be written, the
order in which they will appear, and the type
of file to be written.

Which command allows you to open a new
data table?

READ

The READ command makes a view active. It
also removes any previously active data tables
and associated defined variables, and data
table-specific commands such as RELATE,
SORT or SELECT.

From the WRITE dialog box, what Output
Mode would you select to add data to an
existing table?

APPEND

Records will be added to the existing file or
data table if you select the APPEND option.

The WRITE command can be used to
export a data table to MS Excel.

True

The WRITE command will send records to
an output table or file in the format that you
specify. You can specify what variables will
be written, the order in which they will

14




APPENDIX D

appeatr, and the type of file to be written.

Lesson 10 Epi Report

Which Analysis Output files are accessible by
Epi Report?

Output. XML

Analysis creates two types of files HTML and
XML. The XML file can be used in Epi
Report.

To view a report with complete data
included, click which button?

Generate Reports

Click the Generate Report button or select
File>Generate Report to view a report with
all statistics computed.

Aggregate data can be added to reports from
the Read Data and Create menu.

True

From the Read Data and Create menu, you
can also Read Analysis Output, insert a Line
Listing Group, or create a Pivot Table.

Line Listing groups can be customized from
what dialog box?

Query Builder

The Query Builder allows you to customize
the data that appears in a line listing.

What element is used to insert a graphic into
a report?

Image

Open the Insert Report Object menu in the
Report Elements Tree and drag the word
Image onto the report.

15
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APPENDIX E

Frequency Sections Answers
A. Are there more males or females in the survey population? Females 406
B. Which condition has the highest frequency? Wheezing 12.4%

C. Which month had the highest number of students with
breathing difficulties?

9-September

D. Which school had the highest frequency of students with
bronchitis?

School A-13.8%

E. Which gender has the highest frequency of Asthma?

Males 12.2%

F. How many students answered Yes to Reactive Airway Disease

(RAD)?

93

G. What is the percentage of students with RAD that have been 49.5%
prescribed medication?

H. Which zip code has the highest number of students living in it? | 12046

1. Of that zip code, which condition had the highest frequency? Asthma

J. How many students answered Yes to all four conditions: 16
Asthma, Reactive Airway Disease, Bronchitis, and Wheezing?

K. Based on all four conditions and zip code, are the conditions Yes

evenly distributed among the survey population?

L. Does one school have more students in the affected zip codes
and with all fours conditions than the others do?

Yes- School A

Means Sections Answers
M. What was the most frequent number of missed days? 1
N. What is the mean (average) number of missed days due to 3.76

asthmatic conditions?

O. Which school had the highest average of missed days?

School A- 4.15 days

P. Was the school with the highest average of missed days for
males the same as the school with the highest average of missed
days for females?

No, School A for

Males (4.36) and

School B for Females

16
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4.17)

Q. Is the average number of missed days higher among those who
answered Yes to asthma than the overall average? Refer to
Question N.

Yes, 11.8 versus 3.76

R. What is the average age of the student population?

8.66

Tables Section

Answers

S.  Does one school have a higher number of students with
asthma?

Yes- School A

T. Which school has the highest number of students with School A
wheezing?

U. How many students had both asthma and wheezing? 63

V. What are the odds that you have the condition wheezing, if you | Odds Ratio 42%
have the condition asthma? Risk Ratio 13.6%

W. Is the Odds Ratio for Bronchitis and Reactive Airway Disease | Lower 7.25%
lower or higher than Asthma and Wheezing? Refer to Question
V for the Odds Ratio for Asthma and Wheezing.

X. How many children with the condition wheezing were Children 44
prescribed medication? From those results, what is the Risk Risk Ratio 9.2%

Ratio?

Y. Is the Risk Ratio for being prescribed medication for the
condition asthma higher or lower than being prescribed
medication for wheezing? Compare the results to Question X.

Higher. Risk Ratio
22.2%

Z. Are the risk ratios for Asthma and Wheezing higher for
children under 10 than they are for the survey population as a
whole? Compare the results to Question Y.

Higher. Odds 61.7%
and Risk Ratio 15.9%

17
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Appendix F- Intermediate Analysis Answer Key

The sample .PGMs listed are available in the project Asthma Fina. MDB. The codes listed will
show you an example of how the question could be run using Analysis. Some of the codes
require intermediate steps to create results. Sample programs follow the steps listed in the
lesson. For example, LISTS that require updates must be done manually as they are not saved
as part of the program editor.

Computing Prevalence- Using BRFSS Data BRFSS2003.PGM
A, What is the lifetime asthma prevalence among adults in the 11.7%
state?

B. What is the current asthma prevalence among adults in the | 7.6%
state?

C. Is the state adult asthma prevalence rate higher in the subgroup | Males- 10%
gender? Females- 13.2%

D. Is the state adult asthma prevalence rate higher in the subgroup | Hispanics- 11.2%
ethnicity?

Primary Data- 800 Records Freq4Schools. PGM
E. From the school asthma data, what is the difference in School A- 14.8%
prevalence rates? School B- 12.2%

School C-10.1%
School D- 8.4%

Census Data CountyPrev.PGM
F.  What is the county childhood asthma prevalence? 9.978%
G. What is the county prevalence for the subgroup gender? Males- 9.396%

Females- 10.599%

18
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Mortality Data

MortalityRate. PGM

H. Is the asthma mortality rate for the state and county
significantly different?

State 2000- .179
State 2001- .181
State 2002- .174
County 2000- .136
County 2001-.068
County 2002- .136

10 Year Trends- Hospital Discharge Data

10YRgraph.PGM

| Is the rate of hospital discharge increasing or decreasing in any
age groups?

It appears that the
discharge rate is
cyclical with 1996,
1999, and 2003 being
up years in all age

groups.

3 Year Rates- Hospital Discharge Data

3YRgraph.PGM

J. Are there significant differences in the 3-year discharge rates
for the state versus the county by age?

Rates in all the age
groups appear to go up
in 2003. In NY, the 0-
17 year old age group
has higher rates, while
in Albany the 65+ age
group has the highest
rates.

Mapping Rates

MapRates.PGM

K. Based on the map with hospitalization rates by zip code, which
areas have the highest rates for asthma?

12202, 12207, 12206,
12209, 12041, 12007

19
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Scatter Plots

ScatterPlot. PGM

L. Doesincome appear to affect the rate of hospitalization?

Yes. The number of
discharges appears
much higher in the
lower income brackets.

Risk Ratios- Hospitalization Data

RiskRatioZip.PGM

M. What is the risk ratio of being hospitalized for asthma if you
live in the zip code 12202 versus if you live in the zip code
122117

12202- Risk Ratio 4.5
12211- Risk Ratio .39

Persons living in 12202

are 4 times as likely to

have asthma as those
in 12211 are.

StatCalc

N. From the New York hospital discharge data, how many
records do you need to sample to get a 95% confidence
interval from a sample size of 389987

3602

20
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Appendix G- Preparing Data for Use in the Epi
Info™ Tutorial

The preparation and data management phase is critical for any project involving multiple data
sources. Data management in Epi Info™ requires some forethought into the types of results
needed. The steps used in this tutorial for accessing and formatting data are explained briefly
below. The purpose of this appendix is to provide you with an estimate of the preparation
time and scope of data management used in this project, which you can apply to different
projects in the future.

PREPARATION QUESTIONS

1. Once it was decided to use asthma data, how did you decide what data was needed?
2. Where did you find the data?
3. In what format was the data? HTML, DBF, MS Excel, etc.

4. Did you reformat any of the data? If yes, what did you need to do, and how long did it
take?

5. Where did you get shape files and zip code level maps used in the lessons?

6. How did you format the data so it could be used for mapping?

ANSWERS

1. Once it was decided to use asthma data, how did you decide what data was
needed?

The first step was to understand the context of why asthma information was needed. It
was decided that the scenario would involve applying for an asthma grant. Secondly,
questions were developed and data sources located. The initial questions are included
below.

* The asthma prevalence among adults in the state is ___, and is increasing/decreasing.
(BRESS)

* The prevalence rate of adult asthma is higher in certain subgroups (age, gender,
race/ethnicity. (BRFSS)

* The county adult asthma prevalence rate is higher/lower than the state.
(BRFSS/EBRESS)
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The county adult asthma prevalence is higher in some population subgroups (age,
gender, race/ethnicity). (BRFSS/EBRFESS)

How do the county population sub-group patterns related to the state sub-groups for
adult asthma prevalence? (BRESS/EBRESS)

The current asthma prevalence among children in the state in . (National Asthma
surveillance — NY)

Is the state childhood asthma prevalence higher in any population subgroup?
(National Asthma surveillance — NY)

The county childhood asthma prevalence is __ (primary data collection)
How is the county childhood asthma prevalence different from the state?

Is the asthma mortality rate for the state and county significantly different? (Vital
Records — 3 years)

The rate of hospital discharge from asthma is increasing in __ age group, and
decreasing in ___ age group. (10 year trends, 3 years for map; age group- total, 0-17,
18-64, 65+)

Compare the three-year rates for state vs. county by age. Which are significantly
different?

Hospitalization rate by zip code for 3 years; where are the high risk areas
Look at median family income/ per capita income by zip code.

Look at emergency room data — one-year cross-sectional. What percentage is asthma-
related? Look at age, gendet, race/ethnicity, payment source distributions.

The risk ratio for someone who lives in the __ zip code being hospitalized/seen in
the emergency room for asthma is____ than the other zip codes in the county.

Estimation of sample size for sampling school asthma survey.

From school asthma data of 4 schools (2 high-risk areas, one moderate risk and one
low risk) with 800 records totally, what is the difference in prevalence rates?

2. Where did you find the data?

Data

Source

Hospital Discharge Data — 10
years for trends, 3 years for
maps, payment source, age,
race/ ethnicity, gender

NYSDOH SPARCS database

https://commerce.health.state.ny.us/hin/dataque/data
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numbers by zip code (data
available as an MS Excel file)

(aggregate data) quer.html
Hospital asthma discharge NYSDOH SPARCS database

https://commerce.health.state.ny.us/hin/dataque/data
quer.html

Mortality data - 3 years
(aggregate data)

Bureau of Biometrics, NYSDOH

BRESS — 4 years (aggregate
data)

BRESS Program, NYSDOH

https://commerce.health.state.ny.us/hpn/brfss/default
htm

E-BRESS — 1 year (excel file)

BRESS Program, NYSDOH

https://commerce.health.state.ny.us/hpn/brfss /default
htm

Parent school asthma survey

Sample questionnaire used with permission from the
New York City Department of Health and Mental
Hygiene

Parent School Asthma Survey
(4 schools/200 records each)

hypothetical data was created

Census - zip code level,
county boundary and shape
files, median family and per
capital income, racial/ethnic
distribution,
hospital/emergency rooms,
schools — (aggregate data and
map files)

http:/ /www.census.gov/geo/www/tiger/index.html

National asthma surveillance
Childhood asthma prevalence

(aggregate data)

Asthma Program, Public Health Information Group,
NYSDOH

3. In what format was the data? HI'ML, DBF, .XLS, etc.

Data used in this tutorial were in HTML, MDB, XLS, DBF, and TXT formats.

The process for merging an .MDB and an .XLS file is explained in Lesson 5. Analysis can
READ in 24 different file formats. You can READ in an .XLS file and then WRITE it to
a table inside Analysis for use with the Analysis features. The process of reading and
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writing HTML and .DBF files is covered in the Intermediate Analysis Lesson of this
tutorial. The steps outlined in Intermediate Analysis Lesson for reading in and writing out
an .HTML file can be applied to any format imported into Epi Info™.

. Did you reformat any of the data? If yes, what did you need to do, and how long
did it take?

Yes. The data management steps involved in creating the lessons varied in time taken and
complexity of steps. Here is an example of the kinds of behind-the-scenes steps that were
taken.

If you READ the Numerators table in Analysis, you will see a set of values listed under
the variable Series>Asthma Deaths. The plan was to place the mortality numbers into the
Numerator table to compute rates.

The mortality data came from an .XLS file. The mortality spreadsheet contained a list of
counties and 3 columns with mortality numbers for 3 years in those columns. The . XIS
file was opened in Analysis and written out to a new data table so it could be manipulated.

Once the new table was read into Analysis a set of matching variables to the Numerator
table were defined. For example, SERIES was DEFINED and then ASSIGNED the
value Asthma Deaths. Each year was SELECTed and to get the number of NY deaths
the SUMMARIZE command was used. This new information could then be WRITE
APPENDed to the Numerator table.

Completing the steps for this one section of the final table took about one hour.
Where did you get shape files and zip code level maps used in the lessons?

The US Census Bureau's Cartographic Boundary Files library

(http:/ /www.census.gov/geo/www/cob/bdy_files.html) contains 5-Digit ZIP Code
Tabulation Areas (ZCTAs): 2000 files for download. The site contains files for both ESRI
and Maplnfo for every state in the country. The Maplnfo boundary file data set was
selected due to the accessibility of Maplnfo software by the staff. County specific zip
codes were carved out by creating a query that selected all zip codes from the ESRI zip
code shape file map that were within or partially within a Maplnfo county shape file map.
This county shape file with zip codes carved out was exported into an ESRI shape file
that can be used by Epi Info™.

When downloading files for use in Epi Map select the .SHP download versions. To select
zip code specific information from a downloaded state file, use the Add Partial Layer
feature in the Map Manager and then save the new shape. Shape files are also available
from the Epi Info™ website http://www.cdc.gov/epiinfo.
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6. How did you format the data so it could be used for mapping?
Review Lessons 8 and 9 for all the rules for mapping.

There was data management involved in preparing files for mapping. To map data, it
needs to be in an .MDB format and the zip code field needs to be text. The original
.MDB prepared for the tutorial had to re-worked for use in Epi Map. Once the MDB
was READ into Analysis, the DISPLAY command was used to ensure the zip code field
was text. Since it was not, a new zip code variable was DEFINEd, ASSIGNed, and the
FORMAT command was used so that it would appear as text. Two of the variable titles
also contained underscores, which were removed with, DEFINE and ASSIGN. The new
variables were then WRITE REPLACEA to a new data table for use in mapping.

25



APPENDIX H

Appendix H- Glossary

Terms listed in the Glossary are located in the Epi Info™ online help system and as part of
the online Glossaries listed in Appendix I: Data Sources and the References page.

Analytic Epidemiology

The aspect of epidemiology concerned with the search for health-related causes and effects.
Uses comparison groups, which provide baseline data, to quantify the association between
exposures and outcomes, and test hypotheses about causal relationships.

Chi Square

A test of statistical significance that is used to determine how likely it is that an observed
association between an exposure and a disease could have occurred due to chance alone, if
the exposure was not actually related to the disease. The Chi-Square Test is the test of choice
when the expected values for each cell in a two-by-two table are at least 5.

Confidence Interval (CI)
A range of values for a variable that indicates the likely location of the true value of a measure.
Denominator

The lower portion of a fraction used to calculate a rate or ratio. In a rate, the denominator is
usually the population (or population experience, as in person-years, etc.) at risk.

Descriptive Epidemiology

The aspect of epidemiology concerned with organizing and summarizing health-related data
according to time, place, and person.

Distribution

In epidemiology, the frequency and pattern of health-related characteristics and events in a
population. In statistics, the observed or theoretical frequency of values of a variable.

Epidemiology

The study of the distribution and determinants of health-related states or events in specified
populations, and the application of this study to the control of health problems.

Expressions

Expressions are combinations of literal values, variables, functions, and operators that can be
evaluated to a single result. Within an expression, the values of variables can be modified by a
number of functions and operators. An Expression consists of one or more Operands
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(vatiables or literal values) and one or motre Operators (like +, -, *, and /). Expressions, no
matter how complex, can eventually be evaluated to produce a single value, like 1.323, or
“True” or “False.” Functions modify the value of one or more variables to produce a result.
For example, ROUND (2.33333) produces the value 2. Operators are used to combine two
items. For example, the “+” operator combines Varl and Var2 to produce a sum, as in
Var3=Varl+Var2. Almost all functions require arguments enclosed in parentheses and
separated by commas. Where arguments are required, there may not be any spaces between
the function name and the left parenthesis.

Fisher Exact Test

A test of statistical significance that is used to determine how likely it is that an observed
association between an exposure and a disease could have occurred due to chance alone, if
the exposure was not actually related to the disease. The Fisher Exact Test is the test of choice
when the expected values in a two-by-two table are less than 5.

Incidence Rate

A measure of the frequency with which an event, such as a new case of illness, occurs in a
population over a period of time. The denominator is the population at risk; the numerator is
the number of new cases occurring during a given time period.

Mean

The measure of central location commonly called the average. It is calculated by adding
together all the individual values in a group of measurements and dividing by the number of
values in the group.

Median

The measure of central location that divides a set of data into two equal parts.
Numerator

The upper portion of a fraction.

Odds Ratio

A measure of association, which quantifies the relationship between an exposure and health
outcome from a comparative study; also known as the cross-product ratio.

P-Value

The probability that an observed association between an exposure and a disease could have
occurred due to chance alone, if the exposure was not actually related to the disease.

Percentage
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The number of patients with a characteristic divided by the total number of patients with the
characteristic.

Prevalence

Measure of all cases of disease at a point of time. Computed by dividing the number of cases
by the total population.

Proportion

A type of ratio in which the numerator is included in the denominator. The ratio of a part to
the whole, expressed as a "decimal fraction" (e.g.,, 0.2), as a fraction (1/5), ot, loosely, as a
percentage (20%).

Protective Factor

An aspect of personal behavior or lifestyle, an environmental exposure, or an inborn or
inherited characteristic that is associated with a decreased occurrence of disease or other
health-related event or condition.

Rate

An expression of the frequency with which an event occurs in a defined population.
Ratio

The value obtained by dividing one quantity by another.

Risk

The probability that an event will occur, e.g. that an individual will become ill or die within a
stated period of time or age.

Risk Ratio
A comparison of the risk of some health-related event such as disease or death in two groups.
Standard Deviation

The standard deviation is a mathematical measure of the spread or dispersion of the data
around the mean value for normally distributed data.

Standard Error (of the Mean)

The standard deviation of a theoretical distribution of sample means of a variable around the
true population mean of that variable.

Statistical significance
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The measure of how likely it is that a set of study results could have occurred by chance alone.
The level of statistical significance is usually expressed by the P value.

Trend

A long-term movement or change in frequency, usually upwards or downwards.
Variable

Any characteristic or attribute that can be measured.

Variance

A measure of the dispersion shown by a set of observations.
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Appendix |- Data Sources

Assessment in Public Health

Centers for Disease Control and Prevention (CDC), Division of Public Health Surveillance
and Informatics (DPHSI). Assessment in Public Health. CDC Web site. 2005.

http://www.cdc.gov/epo/dphsi/Al/resources.htm

BRFSS Survey Data

Centers for Disease Control and Prevention (CDC). Behavioral Risk Factor Surveillance System
Survey Data. Atlanta, Georgia: U.S. Department of Health and Human Services, Centers for
Disease Control and Prevention, 2003.

http://www.cdc.gov/brfss/index.htm

CDC Asthma and Allergies

Centers for Disease Control and Prevention (CDC). CDC Health Topic: Asthma and
Allergies. CDC Web site. 2005.

http://www.cdc.gov/health /asthma.htm
CDC WONDER

United States Department of Health and Human Services (US DHHS), Centers for Disease
Control and Prevention (CDC), National Center for Health Statistics (NCHS), "Bridged-Race
Population Estimates, United States, 1990 - 2002, By Age Groups". Compiled from the April
1, 2000 resident population developed by the Bureau of the Census in collaboration with the
NCHS on CDC WONDER On-line Database.

United States Department of Commerce, U.S. Census Bureau, Population Division; Census
Data for Public Health Research, CDC WONDER On-line Database, March 2003.

http://wonder.cde.gov

Community Health Assessment Clearinghouse

New York State, Department of Health (NYSDOH). Community Health Assessment
Clearinghonse. NYSDOH Web site. 2005.

http://www.health.state.ny.us/nysdoh/chac/index.htm
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Epi Info™

Centers for Disease Control and Prevention (CDC), Division of Public Health Surveillance
and Informatics (DPHSI). What Is Epi Info™¢ CDC Web site. 2005.

http://www.cde.gov/epiinfo

The National Center for Health Statistics

Centers for Disease Control and Prevention (CDC), National Center for Health Statistics
(NCHS). CDC Web site. 2005.

http://www.cde.gov/nchs/

Statewide Planning and Research Cooperative System (SPARCS)

New York State Department of Health. "Asthma Hospitalization Rates by County, New
York State Residents 2000-2002." Claritas Corporation. 2005.

United States Census Bureau

U.S. Census Bureau; "Single Years of Age Under 30 Years and Sex 2000, for Albany
County, New York: 2000;" published 2000.

http://www.census.gov/census2000/states/ny.html
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